Mastering the Skills

Preparing to begin

The tutorials in this book use a data set that comes with the text on a DVD. These data must be installed before you start using the tutorials. Each step of the tutorials and all skills learned in this book are illustrated by video clips on the DVD. For instructions on installing the data and using the video clips, consult the Preface and/or the readme.txt documentation on the DVD.

As you are working through the tutorials, you will learn better if you think carefully about each step. Be sure to follow the directions exactly, or you may find that subsequent steps look or behave differently than the book’s instructions.

A TIP gives useful information about the program or settings that will save time or that are important to know. Pay attention to them.

A SKILL TIP tells about a technique that is not covered in a tutorial but that you may wish to learn about later using the Skills Reference at the back of the book. The section of the Skills Reference to consult is indicated in parentheses (ArcMap Basics).

TIP: In these tutorials, values you must enter are shown in this font: type this.

Teaching Tutorial

The following examples provide step-by-step instructions for doing basic tasks and solving basic problems in ArcGIS. The steps you need to do are highlighted with an arrow ➔; follow them carefully. Click on the video number in the Video Index to view a demonstration of the steps.

TIP: This book comes with a folder of data called mgisdata, and you need to know where you installed it. In the examples we use the pathname C:\gisclass\mgisdata, but your folder may be elsewhere. Write down the pathname to its location.

Adding data to ArcMap

1 ➔ Start ArcMap.
2 ➔ In the Getting Started window, click the New Maps text on the left side of the window, indicating that you want to start with a new, empty map document.
3 ➔ Click on the Blank Map template icon, and click OK.

TIP: If using ArcGIS on a network, you may see a different configuration of toolbars. Choose Customize > Toolbars from the main menu, and you will see a list. Only these toolbars should be checked: Draw, Standard, and Tools. If you see others checked, click the names to turn them off.

1 ➔ Click the Add Data button.
2 ➔ Click on the Look in drop-down button to show available data folders (Fig. 1.18).
ArcGIS is able to work with many kinds of data, including files on your hard drive as well as online data. Data on your local computer, or on a network drive mounted on your computer, will be shown in **Folder Connections**, which stores shortcuts to locations containing GIS data.

2 ➔ Click the **Look in** drop-down button again, if necessary, and select **Folder Connections**.

If this is the first time ArcGIS has been used on the computer, this folder will be empty. Otherwise, it may contain connections, which will appear as pathname entries (Fig. 1.19a). You must add a connection to your mgisdata folder to start using your data.

2 ➔ To add a connection, click the **Connect to Folder** button in the **Add Data** window.

2 ➔ Navigate to the directory containing your mgisdata folder and click once on the mgisdata folder icon to select it (Fig. 1.19b; yours may be in a different location). Do not select any of the subfolders in the mgisdata folder. You are adding a connection right now; you will access the data later.

2 ➔ Click **OK** to finish adding the connection.

**TIP:** Once you add a connection it will remain until you disconnect it. Connections tend to build up over time, so disconnect older ones no longer in use. Avoid having multiple pathways to the same folder. Keep connections as uncluttered and simple as possible.

Now that the connection is added, you are ready to start adding data to your map.

3 ➔ Click the **Look in** drop-down one more time to find the connection you added. Click on it to open it.

3 ➔ Double-click the **Oregon** folder to open it.

3 ➔ Double-click the gray **oregondat** icon to open the geodatabase.

3 ➔ Click the **counties** feature class to highlight it; then click **Add** to add it to the map.

4 ➔ Click the **Add Data** button again. This time, double-click the **Transportation** feature dataset to open it.

4 ➔ Click the **airports** feature class; then hold down the **Ctrl**-key and click on the highways feature class. Click **Add** to add them both.
**Viewing the map**

Examine the ArcMap window. The area on the left is called the **Table of Contents**. Examine the first four icons at the top, which present the layers in four different ways. For now, make sure the leftmost icon is clicked to display the layers in the order in which they are drawn, from bottom to top.

The three feature classes you added were placed under a heading called **Layers**. The Layers entry is a **data frame**, which is a box to contain map data to be displayed together.

We will begin by exploring the Tools toolbar. Figure 1.20 shows the tools used for zooming and panning the map.

5. Click the **Zoom In** tool. Place the cursor at the upper-left corner of the state, then click and hold the mouse button down to drag a box around a few counties. When finished, let go of the mouse button.

5. Click once in the lower-right corner of the map to zoom in again.

5. To return to the full extent of the map (useful if you made a mistake or do not like the area you selected), click on the **Full Extent** button.

5. Click on the **Zoom Out** tool and click in the upper-left corner of the state again. The view zooms out with the point clicked at the center.

**TIP:** You can also draw a box using the **Zoom Out** tool. If a large box is drawn, the view zooms out a little bit. If a small box is drawn, the view zooms out a large amount.

6. Click on the **Pan** tool and then click and drag inside the display window to move the map around.

6. Click the **Go Back to Previous Extent** button. It allows you to undo a zoom that you did not intend, or return to an earlier zoom level.

6. Click the **Go to Next Extent** button. It reverses the effect of the **Go Back** button.

6. Click the **Full Extent** button to return to the view of all the counties.

**TIP:** Hover the cursor over a tool for a moment to find out the tool name and what it does.

7. Find the scale readout on the main toolbar and click the drop-down arrow to see a list of preset scales. Choose **1:3,000,000**.

7. Click on the **Fixed Zoom In** button two or three times. It zooms into the next preset scale in the list.

7. Click on the **Fixed Zoom Out** button two or three times. It zooms to the next scale.

7. When finished experimenting, click the **Full Extent** button to return to the full extent of the Oregon data.

**SKILL TIP:** Learn to use the Measure tool to determine areas, lengths, and perimeters in an assortment of different units (ArcMap Basics).
The Identify tool can be used to examine the attributes of a feature.

8 ➔ Locate the Identify tool on the Tools toolbar and click on it.
8 ➔ Place the tool on top of one of the counties, staying away from an airport or a highway, and click on it.
8 ➔ The county will flash on the screen, and the Identify Results box will appear. The attributes of the county are displayed in the Identify window.
8 ➔ Use the scroll bar to examine the attributes in the Identify window.
8 ➔ Click another county and examine its attributes.

1. What is the name of the county in the northeast corner of Oregon? __________________________

9 ➔ In the Identify window, change the Identify from drop-down to highways.
9 ➔ Click on a highway and examine its attributes.
9 ➔ Close the Identify window by clicking the X in the upper-right corner.

**Viewing attribute tables**

To view the attributes for all of the features in a feature class, you can open the table.

10 ➔ Right-click the counties layer in the Table of Contents and choose Open Attribute Table from the context menu that appears.
10 ➔ Scroll to the right, to the end of the table and back, noting all of the fields.

2. How many records (rows) are in this table? __________________________

10 ➔ Hold the cursor over the right edge of the NAME field until it turns into a double arrow bar. Click and drag the edge to increase or reduce the width of the column.

Tables have an options button with various tasks, such as finding text or exporting the table.

11 ➔ Click the Table Options button and choose Find and Replace. Click the Find tab.
11 ➔ Type Hood in the Find what box and click Find Next.
11 ➔ The cursor jumps to the record for Hood River and outlines the data cell.
11 ➔ Examine the other Find options and then close the Find and Replace window.

A context menu gives access to several commands relating to the individual fields.

12 ➔ Right-click the field name POP2000 to display a context menu. Choose Sort Descending. (Make sure you scroll back to the top of the table to see the most populous county, Multnomah.)

3. Which county has the smallest 2000 population? __________________________

12 ➔ Right-click the POP2000 field and choose Statistics to see basic statistics and a frequency diagram of the values. Close the Statistics window when done looking.
12 ➔ Right-click the NAME field and choose Freeze/Unfreeze Column. Scroll to the right, noting that the NAME field stays put now.
12 ➔ Close the counties table by clicking the X in the upper-right corner.
TIP: More than one field can be frozen at a time. Unfreezing allows the field to scroll again, although it remains on the left side until the field settings are reset.

TIP: You can sort, freeze, and do statistics without changing the source data.

Choosing map symbols

Feature classes contain only locations and attributes and do not store symbols or labels. When a feature class is loaded into ArcMap, it becomes a layer. A layer is a specification for how the feature class will look and behave in the map document, and you can set properties to control it.

13 ➔ Click the Add Data button. You last added data from the Transportation feature dataset, so click the Up arrow once to return to the main geodatabase.
13 ➔ Click the volcanoes feature class to select it and click Add.
13 ➔ Right-click the volcanoes layer to make the context menu appear, containing actions or commands that can be performed on the layer.
13 ➔ Move the cursor to the Properties entry at the bottom of the menu, and click it to open the Layer Properties window.

The tabs at the top of the window provide access to menus for setting various properties.

14 ➔ Click on the Symbology tab.
14 ➔ Click on the Symbol button that shows the current symbol. It opens the Symbol Selector window.
14 ➔ Click on the Triangle 1 symbol to use it. Change the color to a reddish-brown and the size to 16. Click OK and then OK again in the Layer Properties window.

TIP: Clicking Apply in a window applies any changes you have made but keeps the window open. Clicking OK applies the change and closes the window.

15 ➔ Right-click the airports layer and choose Properties.
15 ➔ Click on the current symbol button to open the Symbol Selector.
15 ➔ Scroll down and find the Airplane symbol. Select it.
15 ➔ Leave the color black, but increase the size to 25-pt, and set the angle to -45.
15 ➔ Click OK and OK.

SKILL TIP: Learn how to search for and add more symbols to a map than are listed in the Symbol Selector by default (Maps and Symbols).

You don’t have to open the Properties to change the symbols for a layer, however.

16 ➔ Right-click the highways layer symbol (not the text) to bring up a color context menu. Choose the black color.
16 ➔ Click (left-click) on the counties symbol (not the text) to open the Symbol Selector, and choose the Beige symbol.
16 ➔ Click the Outline Color drop-down button and hold the cursor on top of a color box until the color name appears. Set the color to the Gray 20% symbol. Click OK.

Labels are another property of a layer. You can create a set of labels and turn them on or off as you wish.

17 ➔ Right-click the airports layer and open its properties. Click on the Labels tab.
17 ➔ Check the box to Label features in this layer.
17 ➔ The Label Field is preset to NAME, but it could be changed to something else if desired.
17 ➔ Change the symbol to Arial 9-pt Bold font.
17 ➔ Ignore the other options and click OK. The map should now look similar to Figure 1.21.

**TIP:** To remove a layer from the map, right-click it and choose Remove. Removing a layer only takes it out of the map. It does not delete it from the hard drive.

This is a good time to save the map so far.

18 ➔ Choose File > Save As from the main menu.
18 ➔ Navigate to the mgisdata\MapDocuments folder, if necessary.
18 ➔ Enter the name OregonMap and save the map document.

**Layer properties and layer files**

Imagine that you will create series of maps and want airports on all of them. The symbols and labels you just set will appear only in this map. Instead of setting them again each time, you can save these settings as a layer file. A layer file does not contain spatial data, but it points to the original feature class and stores instructions on how to display it.

19 ➔ Right-click the airports layer name and choose Save As Layer File.
19 ➔ Navigate to the mgisdata\Oregon folder.
19 ➔ Enter myairports.lyr as the name of the layer file and click Save.

Nothing obvious happens, but the layer file has been stored on disk for you, ready for the next time you want the airports symbolized this way on a map. We will use it later.

Now let’s examine some of other properties, besides symbols and labels, that can be set for layers. Instead of starting from scratch, we will examine properties already set and stored in a group layer file, which is similar to a layer file but contains properties for multiple layers.

**SKILL TIP:** Learn to create group layers and store them as group layer files (BASICS: General).

20 ➔ Click the New Map File button on the main toolbar to open a new map document.
20 ➔ Choose the Blank Map icon and click OK.
20 ➔ Click the Add Data button. Navigate to the mgisdata\Usa folder.
20. Click on the US Example layer file and choose Add.

Although only the states show in the map window, many layers are listed in the Table of Contents. The check boxes for these layers are gray and cannot be turned on or off. The creator of the layer file applied a scale range to these layers, defining a specific range of scales at which they appear and making sure that they appear only when appropriate.

21. Click the Zoom In tool and zoom in to the western conterminous United States. State capitals and rivers should appear (if they do not, zoom in more).

21. Right-click the Capitals layer and choose Properties. Click the General tab.

21. Examine the Scale Range property (Fig. 1.22). Capitals will be shown only when the user has zoomed in below a scale of 1:40 million. Click Cancel.

22. Locate the Map Scale box on the main toolbar, indicating the current map scale.

22. Click in the Map Scale box and type 40,000,000 (with or without the commas). Click Enter. The map zooms to that scale.

22. Click the Fixed Zoom Out button. The capitals and rivers disappear.

22. Click the Fixed Zoom In button once. They appear again.

22. Click the Fixed Zoom In button a few more times until the labels for the capitals appear. Labels can have a different scale range than the features they represent.

23. Click the Fixed Zoom In button until the interstates and the river labels appear.

23. Continue to zoom in until the counties appear, symbolized by native population.

23. Place the cursor on top of a county and wait. A small label pops up to show the county name. These labels are called MapTips.

MapTips are another property of a layer. They can be set to show the contents of a specified field when the cursor is on top of the feature.

**TIP:** Double-clicking a layer’s name also opens its Properties.

24. Double-click the Counties layer to open its properties and click the Display tab.

24. Examine the settings on this tab. Find the Show MapTips check box.

4. What is the name of the field that is being displayed in the MapTips? 

24. Click the Symbology tab for the Counties layer properties.
24. Instead of a single symbol, this layer is set to display the percentage of Native Americans in the counties. Examine the settings but don’t change anything.

24. Click Cancel to close the Properties window.

**Using the Catalog tab**

The Table of Contents lets you work with layers of your map. The Catalog tab allows you to examine and manage your GIS files. The Catalog tab is an instance of ArcCatalog that runs inside ArcMap rather than as a separate program.

25. Click the Catalog window button on the main toolbar to open it.

25. If it opens docked on the right side of the ArcMap window, leave it there.

25. If it opens elsewhere, click the bar at the Catalog window’s top and drag it to the blue arrow that appears on the right side of the ArcMap window. Release the mouse to dock it.

**SKILL TIP:** Learn how to move and arrange the toolbars, as well as how to use the docking icons and pins to manage windows in ArcGIS (General).

26. Examine the Catalog. A list of folders and data is shown (Fig. 1.23), called the Catalog Tree.

26. Clicking a plus sign expands a folder to show its contents; clicking a minus sign collapses it.

26. If any folders are expanded right now, click the minus signs to close them all.

26. Examine Catalog Tree and find the entry titled Folder Connections. Expand it.

26. The connection to your mgisdata folder, added in Step 2, is already shown. Other connections may be present if ArcGIS has been used on the computer before.

[Fig. 1.23. The Catalog tab]

**TIP:** The Folder Connections entry shows data from your computer’s hard drives or mapped network drives. The Toolboxes folder contains additional commands and tools. The remaining four entries are used to access data from databases or online data sources.

27. Expand the mgisdata folder connection to see its contents.

27. Expand the Rapidcity folder. Inside it, expand the archive folder to examine its contents (Fig. 1.24).

27→ Collapse the archive folder contents.
27→ Expand the Oregon folder.
27→ Expand the oregondata geodatabase (Fig. 1.25). Expand the Transportation feature dataset to see its feature classes.

**SKILL TIP:** Learn to create, copy, rename, and delete GIS files and folders (Files and Geodatabases).

In addition to finding data in the Catalog window, you can get information about individual data sets.

28→ In the Catalog Tree, collapse the Oregon and Rapid City folders.
28→ Expand the Usa folder and the usdata geodatabase.
28→ Right-click the rivers feature class and choose Item Description. It will take a few moments to open.
28→ Read through the information provided about the data set.

**SKILL TIP:** By default only a brief description is shown. Learn how to make ArcCatalog display the complete metadata information (Metadata).

29→ Click the quakehis feature class in the Catalog Tree. The Item Description window updates to show information on this feature class.

You can not only read about a data set but also preview it.

29→ Click on the Preview tab in the Item Description window.
29→ Use the Zoom or Pan tool in the Item Description window to get a closer look.

30→ Change the Geography drop-down to Table to preview the attributes. This Preview window does many of the same things as the Table window in ArcMap.
30→ Right-click the MAG field and choose Sort Descending.
30→ Use the Table Options menu to open Find and Replace. Then search for San Francisco. The cursor in the table highlights the cell when it finds it.
30→ Close the Find/Replace and the Item Description window.

Now that you know it’s the one you want, it is easy to add it to the map.

31→ Click on the quakehis feature class in the Catalog Tree and drag it into the map window. Release the mouse button to drop it in the map.
31  Right-click the quakehis layer symbol in the Table of Contents (not the Catalog Tree) and choose a bright pink color for the earthquakes so that they show up well.

**TIP:** Be careful to select the correct window when right-clicking an item. The Table of Contents window lists map layers, and making changes only affects how the map appears. The Catalog Tree in the Catalog tab lists folders and data sets, and it can permanently change them (usually with no Undo). Be especially careful when working in the Catalog Tree.

Since the Catalog Tree has the potential to change or damage our data if we are not careful, we are going to make it less easy to use it by mistake, while keeping it handy for when we need it. It will also let us see more of our map.

32  Click the Auto Hide button on the Catalog window to hide it, creating a Catalog tab where the window was docked.

32  Hold the cursor over the Catalog tab (no click needed) to open the Catalog window. Move off the window to hide it again.

**TIP:** The Auto Hide button is a toggle switch. If you wanted the Catalog tab to remain open, you would click the Auto Hide button again. Try it now, if you like, but leave it hidden when done.

**Coordinate systems in ArcCatalog and ArcMap**

Both vector and raster data are referenced to the earth’s surface by an x-y coordinate system. Every data set should have a label that indicates the coordinate system used to store its x-y values.

33  Right-click the Capitals layer in the Table of Contents and choose Properties.

33  Click on the Source tab and read the information in the Data Source window.

Two items of interest are shown. First appears the name and pathname of the feature class upon which this layer is based. After it comes the name of the coordinate system, North_America_Equidistant_Conic. Most of the coordinate system information will not make sense until you study Chapter 11, but do note the Linear Unit entry, which is Meter. The x-y values in this data set are stored in meters.

33  Click Cancel to close the Layer Properties window.

33  Open the properties for the Oregon Highways layer.

6. What is the name of this coordinate system? ________________

   What is the linear unit? ______________________

These two layers are stored in different coordinate systems, so which coordinate system is being used for the map? Notice the data frame name, Layers, at the top of the Table of Contents. The data frame has properties also, including the coordinate system used to display its layers.

34  Close the Oregon Highways layer properties.

34  Right-click the Layers data frame name and choose Properties.

34  Click the Coordinate System tab and read the information in the lower panel.
The data frame coordinate system is set to North_America_Equidistant_Conic. The Oregon Highways layer is being converted on-the-fly to match it. You can change the data frame coordinate system to view layers in any coordinate system that you choose.

34 ➔ On the Coordinate System tab, find the Geographic Coordinate Systems folder.
34 ➔ Expand Geographic Coordinate Systems > North America and select the NAD 1983 entry (the simple one in a group is usually the right choice).
34 ➔ The Current coordinate system name in the lower box changes to GCS_North_American_1983. Click OK.

The shapes of the map features change, stretching in the east-west direction. North-south lines that were previously angled become vertical. Changing coordinate systems can dramatically affect the appearance of a map.

35 ➔ Open the Layers data frame properties again to choose another coordinate system.
35 ➔ Expand the Projected Coordinate Systems folder and navigate to the Continental > North America > USA Contiguous Albers Equal Area Conic coordinate system. Select it and click OK.

The map changes again. Every coordinate system causes distortion of areas, distances, shapes, or angles. Each one is designed to minimize or eliminate different kinds of distortion, and the name often gives a hint. An equidistant coordinate system displays accurate distances. An equal area coordinate system displays accurate areas. The best one to use depends on the purpose of the map, which is why data are stored and used in many coordinate systems instead of just one.

TIP: Changing the coordinate system of the data frame only changes the map display. It does not affect the coordinate systems used to store the feature classes.

**Using Internet map services**

Your hard drive or office network drive is not the only source of GIS data. Many organizations host services that provide maps, imagery and data, and individuals can share content on the ArcGIS Online platform. Before we explore these riches, however, let’s see how ArcGIS Help can be a valuable asset in learning more about GIS.

36 ➔ Choose Help > ArcGIS Desktop Help from the main menu bar.
36 ➔ Click on the Contents tab, if necessary.
36 ➔ Expand the entry for Mapping and for *Using web maps and GIS services.*
36 ➔ Click on the entry *What are web maps?* and read through the information.

You can reinforce concepts and learn new things by reading Help. An amazing amount of information is available, equivalent to many books. The Search function helps find the information that you need. Let’s see what it has to say about ArcGIS Online.

37 ➔ Click the Search tab in the Help window.
37 ➔ Type *ArcGIS Online* into the box at the top and click Ask.
37 ➔ Click on *Using ArcGIS Online* and read through the entry.
37 ➔ At the bottom of the entry, click on the link *A quick tour of web maps and GIS services.* Read through it.
37. At the bottom of the entry, click on *What are GIS services?* Read about them.

**TIP:** Use the Search function in Help during a tutorial whenever you’d like to learn more about a tool or concept. Your GIS knowledge and skills will improve dramatically.

Now let’s explore ArcGIS Online. You need a high-speed Internet connection for the next steps. If you are not connected, you may end the tutorial here.

38. Click the New Map File button on the main toolbar and start with a Blank Map. You do not need to save your changes to the previous map.
38. Click the Add Data drop-down triangle and choose Add Basemap.
38. Select the Streets basemap and click Add.

**TIP:** If ArcMap crashes when you try to load a basemap, start ArcMap again. Go to Customize > ArcMap Options and click the Data View tab. Uncheck the box to *Enable hardware acceleration.*

39. Zoom to your home state and then to your home town.
39. Zoom to your home neighborhood and find your street.

**TIP:** Be patient when using Internet services because they can take time to draw. Sometimes they may not be available. If this one does not work, try another, or try again later.

Notice that the map becomes more detailed as you zoom in; map services generally employ scale ranges to show more detailed layers at larger scales. The basemap is only the beginning. Many agencies and individuals provide map data for others to use.

39. Zoom back out so that the conterminous United States is being shown.

40. Click the Add Data drop-down again and choose Add Data from ArcGIS Online.

40. Type *weather* in the search box and click the Search button. Examine the results.
40. Examine the US Weather Warnings service, which should be near the top.
40. Click on the Details link and review the information.

7. Which agency provides the data for this service? _____________________________
   Which agency hosts the GIS server that provides this service? ________________

40. Click the Add link to add the service to your map.
40. Examine the map to find where weather warnings have been issued today.

This map service is continually updated as new information is posted by the National Weather Service. You do not have as much control of a map service as your own layers, but a few display options can be set.

41. Right-click the US Weather Warnings group layer name and choose Properties.
Chapter 1

41→ Examine the Source tab. Note the service URL and the coordinate system.
41→ Click the Advanced tab.
41→ Move the Layer Transparency slider to about 50% and click OK.

Now you can see the underlying base map showing through the warnings.

42→ Click the Identify tool and click on one of the warning polygons.
42→ If the fields in the Identify window look blank, they need to be resized. Place the cursor on a field boundary to resize it and see the information within.
42→ Examine the attributes of several polygons and then close the Identify window.
42→ Expand the US Weather Warnings group subheadings to see legend information.

Remember the Oregon airports layer file that you created earlier? Let’s add it to this map to see if any airports are in a hazard area.

43→ Click the Add Data button and navigate to the mgisdata/Oregon folder.
43→ Select the myairports.lyr layer file and click Add.
43→ A warning message about the geographic coordinate system may appear. If it does, check the box Don’t warn me again in this session and click Close. We will learn more about this warning later.
43→ Right-click the airports layer and choose Zoom to Layer.

Notice that the airplane symbols and labels that you created for this layer were saved in the layer file and recreated when you added it to the map.

44→ Right-click the airports layer and choose Remove.
44→ Zoom in to your home state again.
44→ Right-click the Layers data frame name and open its Properties.
44→ Click the Coordinate System tab, if necessary, and examine the coordinate system of the data frame, which defaulted to the basemap’s coordinate system.

You may notice that your state appears elongated in the east-west direction. The data frame defaults to the coordinate system of the first layer added, in this case, the base map. The distortion is a property of the basemap coordinate system, WGS 1984 Web Mercator Auxiliary Sphere. Let’s use a different coordinate system less likely to distort your home state.

45→ Scroll and collapse folders, if necessary, to find and expand the Projected Coordinate Systems folder and the State Plane folder.
45→ Expand the NAD 1983 (Meters) folder.
45→ Choose a coordinate system for your state. In many cases there will be more than one (for example Maine East and Maine West). Pick the one that best represents the part of the state containing your home town. Click OK.
45→ The map will redraw to a less distorted view of your state.

**TIP:** NAD 1983 stands for North American Datum of 1983. A **datum** is a correction to the coordinate system to make it more accurate. Chapter 11 has more information on datums.
Click the Add Data drop-down button and choose Add Data from ArcGIS Online.

Enter your home state’s name in the Search box and search for data.

Select an interesting map service or layer package and add it to the map.

TIP: Many ArcGIS Online data sets are contributed by ordinary folks, and not all of them work well. If you have trouble getting one to display, remove it and try another.

Let’s view some imagery now. We will open a new map so that the data frame defaults to the coordinate system of the service and does not spend time trying to project the images on-the-fly.

Open a new, blank map. You may save the previous map if you wish.

Choose Add Data > Add Data from ArcGIS Online.

Type the term imagery in the search box.

Examine the details of the World Imagery map service; then add it to the map.

Click the Find button on the Tools toolbar.

Click the Locations tab.

Choose the World Geocode Service (ArcGIS Online) locator.

A locator is an example of a geoprocessing service. When you click Find, the string is sent to the server, which parses it, finds the location by comparing the string to GIS data located on the server, and sends the location back to you. The work is done by the server, not by your computer.

Type New York City in the Single Line Input box and click Find.

Right-click the New York City entry in the bottom of the window and choose Zoom To. Move the Find window out of the way but leave it open.

Set the scale in the Map Scale box to 1:100,000.

Zoom in more to see greater detail.

This map service uses a variety of imagery depending on what is available. The resolution in New York City is sub-meter, but it will not be that good everywhere. Let’s try locating an address instead of a place name.

Type your full home address in the Single Line Input box, including city and state (or equivalent).

If it finds it, right-click it and choose Zoom To. Right-click again and choose Add Point. Zoom in more to see how well the service did at finding your house.

The beauty of GIS servers is that you have access to terabytes of data without having to store them, update them, or download more than the portion you need. The disadvantages are that you must be online, and you may not have access to features or be able to modify the symbols.

This is the end of the tutorial.

Close ArcMap. You don’t need to save your changes.